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About OnTheAir CG Designer… 
OnTheAir CG Designer is a free software developed by Softron. It allows the users to create 
custom CG projects such as animated graphics, lower-thirds, logos, templates…  
With Softron applications, these projects can be played using:  
• OnTheAir CG Designer: used to create projects, and can only play one project at a time. 
• OnTheAir CG Server: can play out multiple projects at a time. This is the one that is 

controlled by OnTheAir Video or OnTheAir Node. More info with its User Manual.  
• OnTheAir Video: our macOS application that allows you to broadcast almost any video clip 

and CG graphics on the playout. More info with its User Manual.  

Simplicity  
OnTheAir CG Designer is presented as an intuitive editing software. Very little setup is 
required, and usage is quick and easy. Each project is represented in a timeline. Each item 
can then be "timed" in the timeline, set when it will "appear" and you can define animations 
such as fades, pushes, and moves. In our code, we work with keyframes, but for you the 
user, it's much simpler, just define an animation and a duration for the animation. 

Flexibility 
For each CG project, you can create an unlimited number of items. The only limitation will be 
what your computer can handle. You can add text (fixed or with moving), shapes, still images, 
movies (in ProRes 4444 with alpha), clocks (digital or analog), or Live items. Each can be 
customized and positioned in the CG project very easily. You can create multiple Live inputs 
in the preferences of OnTheAir CG and use them as you would use other media in a CG 
project. The beauty is that for your Live input you can either use a real video input (AJA, 
Blackmagic-Design, Deltacast or NDI®) or use the direct link feature to receive the frames 
directly from a OnTheAir Video or OnTheAir Node running on the same computer. 

Security 
OnTheAir CG Designer is based on a macOS architecture which is known for reliability and 
flexibility. All solutions developed by Softron Media Services are fully tested and approved 
before released. Prompt and personalized support is also what we do best. 

OnTheAir CG Designer is a very intuitive program with a lot of features and functions. What 
follows is a brief explanation of how to use the application, beginning with installation 
instructions, followed by a description of the User Interface and then with instructions on 
how to get the most from the application. 

In addition to this user manual, you can also find a lot of information: 
• on our website: www.softron.tv; at the bottom of the OnTheAir CG page you find: 

- http://softron.tv/downloads: to download the latest version of OnTheAir CG.   
- Tech Specs: where you will find recommendations on what you need, what drivers 

to use, what video cards and codecs are compatible, etc. 
- Sample projects and AppleScript examples to get started.  

• in our Release notes.  
• on our support desk, there a lot of information is available in the help center. 
• on our YouTube channel, and don’t forget to follow us on Twitter and Facebook. 
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https://softron.tv/products/play/ontheair-video
https://softron.tv/products/play/ontheair-node
https://d1ri0d36xvumy2.cloudfront.net/resources/user_manuals/OnTheAirVideo4_UserManual.pdf
http://www.softron.tv
https://softron.tv/products/play/ontheair-cg?content=overview
https://softron.tv/products/record/multicam-logger?content=downloads
https://softron.tv/products/play/ontheair-cg?content=specs
https://softron-downloads.s3.amazonaws.com/samples/appstest/CG/Softron_CG_Templates.zip
https://softron-downloads.s3.amazonaws.com/samples/appstest/CG/Softron_CG_AppleScripts.zip
http://softron.tv/news/Release-Notes/
https://softron.zendesk.com/hc/en-us
https://www.youtube.com/user/Softronmedia
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What’s New in OnTheAir CG Designer 
With the release of OnTheAir CG Designer 3.6, a lot of changes were made: 

• Effects: Added the ability to Blur an item (in the shapes item, you can create a blur 
item that will blur every layers below it). 

• Animations: Added the ability to do 'Squeeze back" animations on items 
• Smiles: Added the ability to change the "baseline" of a smile  
• Items: Added the ability to "search" or "filter" for items in a project. Very useful when 

you have a lot of items 
• Universal application for better performances on Apple Silicon computers. 
• Full compatibility of NDI with Apple Silicon computers.  
• Updated AJA, Blackmagic-Design and Deltacast SDK to be able to run natively on 

Apple Silicon. 
• Engine: Major rewrite of the graphics engine to use Metal instead of OpenGL. Also 

added support for 10bit output 
• REST API: Added an API to send live subtitling data. Also added the ability to change 

the Font, the fill color and stroke color of a text item 
• Blackmagic-Design devices: Added support for keying with more video formats 

… And many new features on their way !  

To see the latest news, improved features and all the details, go to our Softron website.  
If you want to submit a request, contact our support team, always ready to help you!  

Warnings and Important modifications 

• There is no installer anymore. Just drag and drop the application to the Applications 
folder.  

• As there is no installer anymore, this implies that Sample projects and AppleScript 
examples t are not installed. They can be downloaded here or from our website.  

• For developers using the API there are 2 major changes: 
◦ you should now use "snake_case" instead of "camelCase" 
◦ You now have to specify the "Content-Type" to "application/json" in your 

requests 
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https://softron.tv/support/release-notes/?category=MovieRecorder
https://softron.zendesk.com/hc/en-us/requests/new
https://softron-downloads.s3.amazonaws.com/samples/appstest/CG/Softron_CG_Templates.zip
https://softron-downloads.s3.amazonaws.com/samples/appstest/CG/Softron_CG_AppleScripts.zip
https://softron-downloads.s3.amazonaws.com/samples/appstest/CG/Softron_CG_AppleScripts.zip
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Software Installation 
OnTheAir CG is composed of two different applications: 

• OnTheAir CG Designer is used to create projects, and can only play one project at 
a time. 

• OnTheAir CG Server plays out projects, and can play out multiple projects at a 
time. This is the one that is controlled by OnTheAir Video or OnTheAir Node. 

1. OnTheAir CG Designer and OnTheAir CG Server can be downloaded directly from our 
Downloads page on our Softron website.  

2. Drag and drop the OnTheAir CG Designer and OnTheAir CG Server application into your 
applications folder. 

First Start 

1. Start the application: Double click on the OnTheAir CG Designer/Server icon in your 
Applications folder 

2. When prompted with the message the “OnTheAirCGDesigner.app” or 
“OnTheAirCGServer.app” is an application downloaded from the Internet. Are you sure 
you want to open it?”, Click on Open. 

3. On both app, a license agreement window will open. Enter your First and last name and 
a valid email address. Tick the check-box and click on “Accept” 

4. Enter an admin password, to install the required components 

5. If you have a dongle connected to the computer with valid licenses for OnTheAir CG, 
the applications will start right away. 

6. If you do not have a dongle connected, a license window will open to offer you 3 
choices: 

• Register: if you own a serial number, click on this button and follow the procedure 
to activate it. You can read more about the activation procedures on our support 
desk. While either OnTheAir CG Designer and OnTheAir CG Server can output to a 
video device, only the one with the license activated will output without a blue 
demo watermark. It is recommended that you activate your license on the 
OnTheAir CG Server application, and use the OnTheAir CG Designer in "DEMO" 
mode. OnTheAir CG Server will then be used to play out the projects. 

• Buy: if you don’t have a serial number, but want to buy one, click on that button. 
• Demo: if you want to try the application in DEMO mode, click here. If you want to 

add a license, and upgrade or option later on, you can access the license window 
in the Menu “OnTheAir CG Designer > Licenses…”. Even with OnTheAir CG 
Designer in DEMO mode, there are no limitations on the number of projects you 
create, and you may preview them in the user interface. 

7. That’s it — you are ready to use OnTheAir CG Designer! 

More information to understand the difference between OnTheAir CG Designer and 
OnTheAir CG Server in our article “The differences and how to use licenses”. 
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https://softron.tv/products/play/ontheair-cg?content=downloads
https://softron.zendesk.com/hc/en-us/sections/201275327-Licenses-De-Activations-Dongles-Options
https://softron.zendesk.com/hc/en-us/sections/201275327-Licenses-De-Activations-Dongles-Options
https://softron.zendesk.com/hc/en-us/articles/213161937-OnTheAir-CG-Designer-vs-OnTheAir-CG-Server-differences-and-how-to-use-licenses
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1. Overview of OnTheAir CG Designer 
The OnTheAir CG Designer User Interface has one main window with four areas: 
• Projects (the top left of the screen)  
• Composition Area (the center of the screen) 
• Items & Timeline (the bottom part of the screen) 
• Inspector (the top right of the screen) 

1.1. Projects 
The Projects area displays projects that you have previously designed.  
• You may modify an existing project by clicking on it and using the 

tools presented elsewhere. 
• Click on “+” to create a new project or open an existing one.  
• Click on “-“ to close a project. If that project has not been save before, 

a window will pop to “Save it” on the location you select. Here is an 
example below:  
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1.2. Composition Area 
The large central panel in the User Interface (UI) is where the project is displayed. As you 
add, subtract, or otherwise change features, the Composition Area will reflect those 
changes. Clicking on Items within the Composition Area allows you to modify certain 
features of the item, such as it’s location and it’s dimensions. 

You may change the location by clicking on the Item and pulling where you would like it to 
be displayed. The dimensions may be changed by clicking on the Item and then 
manipulating the borders by dragging the white squares in the Item’s perimeter. 

1.2.1. The Tool Bar 

At the bottom of the Composition Area, you can find see a the left of the Tool Bar: 

Each Icon is used to select a type of Tool to be created. Clicking on a Tool Icon causes it to 
turn blue, indicating that it has been selected. Once an Icon is selected, clicking on the 
Display creates an Item that can be resized and moved about the Composition area.  

• Arrow: This sets your cursor to an arrow, allowing you to interact with the UI. 

• Text: Clicking this opens a text box wherein you may double-click to add text. 

• Ticker: Right-clicking on it gives you the option to create a 
Ticker with text created from a folder, through a Web feed, or 
entered manually. More explanations in the next chapters… 

• Image: This allows you to select a still photo file from Finder. 
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• Movie: This allows you to select a video file from folder 

• Clock: This allows you to create a clock display. Right-clicking on 
the icon allows you to set the display to either an analog or digital 
clock. 

• Shape: This is used to add a shape to the display. Right clicking 
on it allows you to change the shape to either a rectangle, a 
rounded rectangle, an ellipse or a blur (explained in the next 
chapters…) 

• Live: The last icon allows you to insert a Live video feed. 

More information about how to edit these items. Go to chapter “How to Add and Edit Items”. 

On the right of the Tool bar, you can find two arrow keys: 

The left-pointing arrow moves the project to the beginning of its Timeline. The right pointing 
arrow acts as a Play button for the project.  
Below the bottom right-hand corner of the display are Zoom controls (note that you can use 
the sliding bar or right-click on the Magnifying Glass icon to select a Zoom Level from a pop-
up menu): 

1.2.2. The Viewer Parameters  

At the top right, you can see a gear icon with a list of parameters for the Composition Area: 

> Show on Screen: only during the composition.  
• Checkboard Background: show the transparency grid. 
• Title and Safe Area: To ensure your graphics don’t get 

cut off on the screens.  

> Show on Video output: parameters visible in the output.  
• Selection Area: of the items in your projet 
• Checkboard Background: show the transparency grid. 
• Title and Safe Area: To ensure your graphics don’t get 

cut off on the screens. 
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1.3. Items and Timeline 
The "Items" area displays the Items you have created in your project, and right next to them 
is the timeline area where you can view and modify the  
 of each item. 

1.3.1. The Items 
 

• You can enable or disable items using the checkboxes on the left. 
•   • The padlock on the right allows you to lock and unlock an item. When locked you won’t 

be able to modify it in the Composition area.  
•• Clicking on an Item highlights it and the corresponding Timeline to the right, and opens 

controls on the Inspector Panel specific to that particular Item Type.  
•• The order of the Items corresponds to the hierarchy of layering in the project. Items at 

the top of the list are layered over Items lower on the list. Items can be moved by 
dragging and dropping them wherever you would like them on the list, and hence in the 
layering hierarchy.  

You may also adjust the items’ hierarchy by selecting the Item 
and then clicking Item in the Menu Bar, and from their moving 
the item as you desire. 
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1.3.2. The Timeline 
 
Each bar in the Timeline coincides with the Item to its left. 

• Above the Timeline bars are times that coincide to the Project’s play time. 

• As the project is played, a white Timeline Marker will move along the Timeline, showing 
the current point of time in the project’s playout.  

• The small orange markers represent Pause Frames in your project. When a Pause Frame 
is set in the Timeline, the project is set on “Hold” at that point of time. That means it 
requires a trigger or an action to play back. It is useful if you have multiple animations, or 
different actions to trigger on the same project (A squeeze Back for example, more 
explanations in the next chapters…).  

> If you want to add/remove/Go to Previous  
or Next Pause Frame, go to the top menu 
“Timing”. The actions and the keyboard 
shortcuts on the picture here: 

• The Timing Bars begin and end at the times selected in the Delay and Hold features in 
the Item’s Timing section. 

• Items that are Faded in or out have sloping beginnings or endings. The start point of the 
slope coincides to when the Fade begins, while the end point of the slope coincides to 
when the Fade ends. 

• Below the Timing Bars is a magnifying glass icon. Clicking on it brings up a sliding Zoom 
bar, allowing you to increase or decrease the spaces between the times. Clicking on the 
1:1 button returns the spacing to the default setting. 
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1.4. Inspector 

• The Inspector panel is the section where the Items 
in your project are fine-tuned.  

• Clicking on an Item in the Items panel brings up a 
number of features specific to each Item Type 
(discussed in the chapter “Item”, by Item Type).  

• Note that by holding your cursor over the right-hand 
corner of each feature section allows you to Hide or 
Show that section. 

• There are multiple sections in the Inspector, 
depending on which Item is selected. We will go 
through these in detail when talking about each 
item. 

• The Inspector is also used to set up the attributes of 
a new projects. More information in chapter “Create 
a Project”.  
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2. Create a Project  
To create a new project:  
• Click on the “+” icon on the bottom left of the panel  
   Or  
• Go to the top menu “File > New” 
You may also reopen a project by selecting “File > Open…” or “File > Open Recent” in the 
Menu Bar, or by clicking on the “+” icon in the Projects area and selecting “Add existing 
projects.”  
Once you have created your project, you must save it by selecting “File > Save As”. 

2.1. The Playback Settings  
To play out your Project with OnTheAirCG Designer, you must set up your playback settings. 
To do so, select “OnTheAir CG > Settings… > Outputs”: 
  
Clicking this opens the Outputs panel, which allows you to set up your Player Settings. Any 
changes made to the Outputs settings must be saved by clicking the Apply button on the 
bottom right corner of the panel. 
Select the device that will be used as the main video and audio output. A reminder that 
OnTheAir CG Designer supports AJA, Blackmagic-Design and Deltacast cards, Thunderbolt 
devices, as well as NDI. 

Different options are included (available options depend on the video device used): 
  
• Video & Audio Output Device: This 

allows you to select any available video 
outputs to play your graphic from 
OnTheAir CG Designer.  

• Video Format: From here you may select 
the format you would like to play out your 
clips. The list is quite extensive (60 
different formats), ranging from SD to 8k. 

• Pixel Format: You may choose either YUV 
8 bits, YUV 10 bits or ARGB as your Pixel 
Format. 

• Audio Channels: You may select 1, 2, 8, 
16, 32 or 64 audio channels. 

• Sample Size: Your Sample Size may be 
either 16 or 32 bits per package. 

• Keying: If you need to overlay dynamic graphics. Important information about Internal, 
External Key vs Live Sources in our website article. 
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https://softron.zendesk.com/hc/en-us/articles/207695127-Different-setup-for-OnTheAir-CG-Internal-External-Key-vs-Live-Sources
https://softron.zendesk.com/hc/en-us/articles/207695127-Different-setup-for-OnTheAir-CG-Internal-External-Key-vs-Live-Sources
https://softron.zendesk.com/hc/en-us/articles/207695127-Different-setup-for-OnTheAir-CG-Internal-External-Key-vs-Live-Sources
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2.2. The Project Settings  
When you select a project in the project lists, and no item is selected, the inspector will only 
show the Project settings: 

• Video Mode: The format and the frame rate of the output (from SD to 8k). Note that if you 
have set your project to be 1080p59.94, but play it in a 4K output for example, the project 
will not be scaled to the output. It will look small at the bottom left of the screen. So 
choose the same Mode for your project as the your playback settings. 

• Auto Start and Stop: It is used with folder based tickers, and web feed tickers. The ideas 
is that if there is no text to be displayed in the ticker, you don’t want to see the eventual 
background that was set. These 2 settings will allow you to force the whole project to 
start or stop if there is text crawling or not. This feature only works with tickers, so first 
you will need to add a "Ticker" item to your project. Once that is done, click on the popup 
menu and select which (if there are multiple ones) tickers should be running: 

You can select one for the auto start and/or one for the auto stop: 

That way:  
> When the "Ticker Item" is running (there is a text file in the folder and/or 
content in the RSS feed), the whole project will play  
> When the "Ticker Item" is NOT running (there is no text file in the folder and/
or there is no content in the RSS feed), the whole project will stop playing. 
When there are no text to be displayed, the status of the project in OnTheAir 
CG Server will be "Waiting" 

• Smiles: To add your "Smiley" for graphics integration. More explanations in our website 
article Work with “Smiles". 
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3. How to Add and Edit Items  
Once you have created (or reopened) and set up your project, you can add items to it. For 
that, simply select the project, click on any of the tools at the bottom to create a shape, text, 
still image, video, clock or live item.  

As seen before, depending on the type of item created you will see different kinds of 
information in the Inspector. Geometry and Timing are always shown for all items. 

3.1. Installing the Sample Documents 
If you need samples to help you start, we have multiple CG projects available free on our 
website.  

In our OnTheAir CG webpage, go to the “Downloads” section. you will be able to install 
some example documents: 

3 sections with these samples:  
• Simple Projects: are as its name implies some simple project samples to show you what 

can be done. 
• AppleScripts: Are sample documents (CG project and AppleScript itself) to show how to 

control OnTheAir CG Server with AppleScripts. 
• HTML Pages: Are sample documents (CG projects and HTML pages) to show you how to 

control OnTheAir CG Server with the REST API. 

More explanations in the OnTheAir CG Server User Manual. Available to download in our 
website.  
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3.2. Geometry 
You can position and resize items directly in the "Composition" area. But sometimes it is 
easier to work in the inspector. The Geometry section of the inspector allows you to fine-
tune the dimensions and location of the Item. 

• Position: This allows you to move the Item up and down (on the X and Y axes) in the 
Display via the arrows to the right of the boxes or by left clicking on the box and entering a 
number in the box itself. The bottom left-hand corner is the 0 point for both axes.  

• Size: This allows you to adjust the dimensions (Width and Height) of the Item. Checking the 
“Keep Aspect Ratio” maintains the Width to Height ratio as you adjust one or the other. The 
1:1 button reverts the Item to its natural size — if, for example, the Item is a 1920 x 1080 
video clip and you resized it to 1600 x 910, clicking on the button returns the clip size to its 
original 1920 x 1080.  

• Align: This allows you to adjust the alignment of the Item on the Composition panel. 

• Spacing: This allows you to adjust the distance between two or more Items. You may hold 
the “⇧” or “ctrl” keys to select the Items, and use the arrow keys to set the number of 
pixels that separate them.        
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3.3. Item’s Timing 
When you have created an item, you can add a start and end transition, as well as set a 
duration. 

3.3.1. In the Timeline 

The easiest way to handle the timing of items is to do it directly in the timeline (though you 
may also do so via the options in the Time tab in the Menu Bar) 

You can simply select an item in the list, then position the playhead where you want and use 
keyboard shortcuts :  
• U = set the start of the "In" transition  
• I = set the end of the "In" transition 
• O = set the start of the "Out" transition 
• P = set the end of the "Out" transition  

You can select multiple items and change all their timing information at once. You can also 
simply drag and drop the different elements directly into the timeline. If you want to change 
the type of transitions, however, you’ll have to do that in the inspector. 

3.3.2. In the Inspector 

The Timing section allows you to set the time you’d like an Item to present itself, and when 
you’d like it to exit. Here you may also set the Transition effects for the Item: 
  
• Delay: In the Delay box you may set the 

time, in seconds measured after the 
start of the Project, in which the Item 
will be displayed.  

• In Transition: This is where the 
Transition effects are set up for the start 
of the Item, and includes four items: 
Type, Option, Duration, and Hold.  

• Type: You may choose from four 
different transition effects: None, Fade, 
Push, Push and Crop or Move and 
Scale.   

• Option: The Push (and Push and Crop) 
effects allow you to choose the 
direction from which the Item is 
introduced. You select that from here.  

> Go to page 3 <



-  -17

OnTheAir CG Designer

• Duration: This is where you set the duration of the transition effect. 

• Hold: Here you select, in seconds, how long you would like the Item to be present in the 
project. You may instead set the Item to remain in the project indefinitely by checking the 
“Stay Forever” box.  

• Out Transition: This is where Transition effects are set up to end the Item, and are set up 
in the same way as the In Transition effects. 

3.4. "Publish" Items (REST API) 
Most items (such as Text, images, tickers) have a "Publish" option: 

When this option is enabled, you will be able to modify it through the REST API and 
OnTheAIR CG Server. You need to enable this option if you intend for example to modify a 
text field from: 

• OnTheAir Video: Read our article “Control OnTheAir CG Server from OnTheAir Video” 
Or 
• OnTheAir Node: Read our article “Control OnTheAir CG Server from OnTheAir Node” 

But also if you work with the REST API to control OnTheAir CG Server, only the "published" 
items will be modifiable through the REST API. 

You can also control OnTheAir CG remotely through AppleScript and HTTP. More 
information in the OnTheAir CG Server User Manual.  
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https://softron.tv/products/play/ontheair-cg?content=downloads
https://softron.zendesk.com/hc/en-us/articles/215330478-HOW-TO-Control-OnTheAir-CG-Server-from-OnTheAir-Video
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3.5. Text Items 
Select the Text Item of the list. Then, make your selection (Text Box) in the Composition area:  

The Text Field Item Type includes a Text section in the Inspector: 

• Font: Here you may select the font you would like to use for the text, as well as the 
different varieties of that font (Regular, Bold, Oblique, etc — the choices vary by Font).  

• Size: Here you set the size of the font you are using. To the right of that selection is a 
colored line, with which you choose the color of the font.  

• Stroke: Here you determine the thickness and color of the Text’s outlines.  

• Alignment: Here you may select the Text’s alignment within the Text box created in the 
Text Tool.  

• Text: This box is where you enter whatever text you would like to display.  

• Max Characters: You can determine a characters limit in your text item.  

• Shrink To Fit: It will resize automatically the Text to fit in the Text Box. 

• Resize Text box with content: The Text box will fit automatically to the Text. 

• Rich Text: Checking this box allows you to use different font sizes and styles in the Text.  

• Publish as ‘TextField’: Checking this box allows you to use this piece of the Project with 
any application that allows the integration of OnTheAirCG, such as OnTheAir Node or 
OnTheAir Video. More information in the section "Publish" Items (REST API)”. 
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3.6. Tickers 
You can use 3 types of tickers in OnTheAir CG. To select 
which type you want to use, click and hold on the "Ticker 
item" icon, and a menu should show up: 

Here are what each are: 
• Folder-Based: You point to a folder in which you place one (or more) text files, and 

OnTheAir CG will pick the files and overlay them 
• Manual: The text is entered in the inspector in OnTheAir CG Designer (or through the API) 
• Web Feed: You reference an url to a RSS feed, and OnTheAir CG will retrieve the RSS title 

and descriptions. 

After you have selected the type of ticker you want to use, click and drag a zone in the 
Viewer to set in which area the ticker will crawl. 

3.6.1. Folder-Based Ticker  

When you create a Folder-Based ticker, select your folder and check the Inspector: 

• Font, Size, Stroke and Alignment: (Left/Right/
Center, Top/Middle/Bottom) 

• Speed: at which the ticker will crawl (in pixel 
per seconds) 

• Direction: in which the ticker will go 

• Source of the ticker: the folder in which you 
will place the text file(s). 

• Separator: that will be used in between the different text files that you will place in the 
folder. This is a text, but if you combine this with the "Smile" feature, you can replace this 
text by an image for a nice looking ticker. 

• Play Content Only Once: when enabled, if you place a text in the folder, OnTheAir CG will 
display the whole text only once, then stop. 

• Publish as 'Ticker Item': when enabled you will be able to get access to it through the 
REST API or the AppleScripts. This is useful for third party integration or to control from 
OnTheAir Video or OnTheAir Node. 
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3.6.2. Manual Ticker  

When you create a Manual ticker, select it and check the Inspector: 

• Font, Size, Stroke: For your text. 

• Alignment: Here you may select the Text’s alignment within the Text box created in the 
Text Tool (Left/Right/Center, Top/Middle/Bottom). 

• Speed: at which the ticker will crawl (in pixel per seconds) 

• Direction: in which the ticker will go 

• Text: This box is where you enter whatever text you would like to display.  

• Max Characters: You can determine a characters limit in your text item.  

• Shrink To Fit: It will resize automatically the Text to fit in the Text Box. 

• Resize Text box with content: The Text box will fit automatically to the Text. 

• Rich Text: Checking this box allows you to use different font sizes and styles in the Text.  

• Play Content Only Once: The text will only be played once in the playout. 

• Publish as ‘Ticker Item’: Checking this box allows you to use this piece of the Project with 
any application that allows the integration of OnTheAirCG, such as OnTheAir Node or 
OnTheAir Video. More information in the section "Publish" Items (REST API)”. 

> Go to page 3 <



-  -21

OnTheAir CG Designer

3.6.3. Web Feed Ticker  

Select the Web Feed Ticker and check the inspector here is what you should see: 

• Font, Size, Stroke: For your text. 

• Alignment: Select the Text’s alignment within the Text box created in the Text Tool (Left/
Right/Center, Top/Middle/Bottom). 

• Speed: at which the ticker will crawl (in pixel per seconds) 

• Direction: in which the ticker will go 

• Feed URL: Here is entered the URL of the RSS feed you would like displayed in the Ticker. 

• Separator: Enter text here to separate the RSS feeds you receive from the URL address.P 
• Sort by: Here you may select the manner in which the RSS feeds are displayed. 

• Refresh: This feature allows you to refresh the RSS feed at certain increments. 

• Title: Checking this block displays the RSS feeds’ titles in the Ticker. 

• Description: Checking this displays the RSS feed’s description in the Ticker. 

• Content: Checking this only shows the RSS feed’s content. 

• Play Content Only Once: The text will only be played once in the playout. 

• Publish as ‘Web Feed Ticker’: Checking this box allows you to use this piece of the 
Project with any application that allows the integration of OnTheAirCG, such as OnTheAir 
Node or OnTheAir Video. 
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3.7. Image 
The Image Tool has an Image section, which allows you to select and modify a still image (or 
sequence of still images, to form animation). 

• Name: This is the name of the still file you would like to display. A folder icon to the right of 
the Name box allows you to select the file from Finder.  

• Location: This is file path for the still image you have selected. 

• Preview: A thumbnail of the still image is displayed here. To the right of it are the the item’s 
dimensions and arrow icons that allow you to rotate the image. The up arrows flips the 
image upside down, while the right-facing arrows flips the image from right to left. 

• Animation: If the file location contains a series of images and the Image Sequence box is 
checked, the images will all be displayed, in order, at a duration you set up in the “Frames/
Img.” box. Set for how long each image will be displayed. By default, each image is played 
for the duration of one frame. But you can also set that each image is displayed during 2 
frames, or longer, and thus playing it for longer. This creates an animated sequence of the 
images. If the Loop box is checked, the animation will continue to repeat itself.  

• Publish: This works as in the other sections, above. 
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3.8. Movie 
The Movie Tool contains a Movie section, wherein you may select the video clip to be 
played in the project, view information on the clip, and set options for the video’s playout. 

• Name: This is the name of the video file you would like to be shown on the Display. 

• Location: This is the path to the folder in which your video clip is located.  

• Format: This is the format of the video file. FPS: This is the frame rate of the video file.  

• Duration: This is the duration of the video file, in Hours:Minutes:Seconds:Frames.  

• Size: This shows the dimensions of the video file.  

• Field Order: By default, the Upper Field is first when playing out Interlaced files.  

• Loop: This allows you to play the video file in a loop.  

• Allow Smart Resize: This allows the Smart Resize feature to be active, which allows the 
high quality resizing of interlaced videos. Invert  

• Field Order: This changes the field order of interlaced video files.  

• Premultiply Alpha: This allows you premultiply the alpha.  

• Closed Caption: If the QuickTime video file (.mov) that you play has a Closed Captioning 
CEA-708 track, and it uses the same format as the playback format of OnTheAir CG, it will 
be outputted to the video card through the VANC. Note that you can only have one movie 
with the option enabled per project, otherwise there will be a conflict between the two.  

• Continue Playback on Pause: Even with a pause frame, the video is still playing.  

• Publish: This works as in the other sections, above. 
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3.9. Clock 
There are two separate Clock Tools available (Digital and Analog), 
and each includes its own feature. You can also find detailed 
information on our website article.  

3.9.1. Digital Clock 

The Digital Clock Tool has a Text feature section: 

• Font, Size, Stroke, Alignment, and Publish all work as per the Text Field Item, above.  
• Format: These controls allow you to change the format of the clock’s display (for example, 

from a 12 hour AM/PM cycle to a 24 hour cycle). The Result of the formatting shows an 
example of how the clock will be shown in response to the Format chosen. 

3.9.2. Analog Clock 

The Analog Clock Tool has an Image feature section, which operates just like that of the 
Image Tool: 

More information about the option in the Image Tool chapter.  
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3.10. Shape Items 
Four shapes are available in OnTheAir CG Designer. The Rectangle, 
the Rounded Rectangle, the Ellipse and the Blur. To select one, right 
click on the Item Tool.  

3.10.1. The Shapes  

The Shape Item Tool contains two unique sections: Stroke and Fill. The Stroke section 
allows you to create and modify an outline for the shape you have crated.  

Stroke  

• Stroke: This allows you to change the 
color and thickness of the outline (a 
thickness of 0 leaves no outline).  

• Pattern: This allows you to set a pattern 
for the outline, i.e. a solid line or dashed 
line. If you select a dashed or dotted 
outline, you can modify the layout of the 
dashes (or dots) with the Dash and Gap 
boxes.  

• C. Radius: This allows you to change the corner radius on a rectangle or rounded 
rectangle shape.  

Fill Type 

• Fill Type: You may select how you would like the shape to be filled.  

• Color: This fills the shape with a solid color, selected from the colored box to the left (or by 
adjusting the RGBA display to the right of the colored box).  

• Linear Gradient: This fills the shape with a gradually darkening color from top to bottom 
(or you may click on points on the color bar to add colors to the shape); Angle allows you 
to change the angle of the shape, while Invert flips the shape 180 degrees. 

• Radial Gradient: This fills the shape with a gradually darkening circle that gets darker as it 
radiates from the center (or you may click on points on the color bar to add colors to the 
shape); Angle allows you to change the angle of the shape, while Invert reverses the order 
of color. 

3.10.2. The Blur 

Added the ability to Blur an item (in the shapes item, you can create a blur item that will blur 
every layers below it. Work in progress as it is not yet possible to set the blur value). 
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3.11. Live Source 
The Live Tool contains a Live section that allows you to select a Source for the Live Input. 

• Source: Here you select the Source of the Live Input. If the Source is available, a green 
check mark will be displayed. If not, a red circle will be displayed. To use the Live Sources, 
you must first set up your sources in the “Settings > Live” l. There you may add (+) or 
remove (-) sources. When you add a source, you must select a Video Device Input (any 
connected devices will be automatically detected). You may change the input device by 
clicking on the gear icon and choosing from the selection shown there. OnTheAir Video 
support video cards with SDI or Thunderbolt connector (Blackmagic Design, AJA and 
Deltacast), NDI Sources and Virtual Sources. 

• Allow Smart Resize: This allows the Smart Resize feature to be active, which allows the 
high quality resizing of interlaced videos. Invert  

• Field Order: This changes the field order of interlaced video files. 

• Always Active: Enable this option, if you want to always have your Live Input running.  
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3.12. The Squeeze Back 
An example (with a Video clip and a Live Source) is available in the sample templates you 
can download free on our webpage. 

The “Squeeze Back” is an animation that allows you change the size and position of an item 
while playing your project. A perfect exemple would be, during a show, if you want to put 
information or advertising to the side of the content: 

  

Start Transition (Timing : 00:00:00)	 	 	 	            End transition (Timing : 00 : 00 : 01)  
 

• To do so, set a “Movie” or a “Live Source” Item. 

• Set its position in the Composition area. 

• Then, select the item, go to the Timing window 
(Inspector) and select “Move and Scale” for your 
In Transition and your Out Transition.  

• Use the Pause Frames to set action points that 
will be triggered with an external control (In and 
Out Transition). 

• For both In and Out Transition, click on “Edit Geometry” and set the positions for the start 
and the end of the Transition. Click on the green icon at the top right corner to validate 
your settings each time.  

• That’s it, you have set a Squeeze Back! 
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4. Work with "Smiles" 
 
Smiles are used to replace a text by an image, exactly as when you type ;-) on some smart 
phones it will be replaced by       . This is very useful in tickers for example, so you can 
replace parts of the ticker by an image. It can be a fixed or animated image sequences. 

4.1. Setting up Smiles 

To create a new “Smile": 
• Click on the “+” icon 
• Select a still image or the first image of an animated sequence “tga” 

• Then to edit the settings of the smile, double click on it, so the following window opens: 

There you can edit 2 main things:  
• Animation: If it’s an still image or image sequence (enable the Image sequence option) 
• Modify the "Alias". The alias is the text that will be searched for and replaced by the image. 

Make sure that this text is unique. We offer a sample of what you could use but you can set 
it to something easier.  

As soon as that is done, and in a text item (fixed, ticker, …) you type what you have set in the 
"Alias" of the smile, it will be replaced by the image. Again this can be used in tickers, but 
also in fixed text as a quick way to add an image somewhere automatically. 
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4.2. Using Smiles in items 
Once you have configured your Smile, you can start using it in any text items that you want 
in your project. 

You can use Smiles in Text or Ticker items. Let's do it in a simple text file for this example. 
Click on the text item icon at the bottom of the preview area and create a text item. Then in 
the "Inspector > Text",  just enter the "Alias" that you have configured. In our example, let's 
enter  #SMSLogo: 

As soon as you have entered the text corresponding to your equivalent, you will see in the 
Preview area that your text is replaced by the image: 

Note that the size of the image depend on the size of the Font used. So you may want to 
change this in the "Inspector > Text" area. 
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5. When Something Goes Wrong… 
While we strive to ensure that OnTheAir CG Designer be as stable a platform as is humanly 
possible, there is a lot of interaction between our software and other pieces of your 
workflow (your MacOS, video card drivers, switchers, etc.), and so we must constantly evolve 
our product to adapt to changes made in those applications. As such, bugs do sometimes 
sneak up on us. Should any issues arise while utilizing OnTheAir CG Designer, the first place 
to look for answers to potential causes is our white pages on our Softron Support Desk 
website.   

And also keep in mind that for the life of the product, your application includes free support.  
The best way to reach us is via “Help > Contact Softron Support” in the user interface of the 
application (see below for image).  Through that button you can collect the technical logs 
from the application and open a support ticket on our Support Desk.  It is important that 
when opening a ticket that you supply as much information as possible, including the date 
and time of the incident(s).  
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